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Abstract 

This document describes the HP software update catalog for Microsoft® System Center products. It also provides an 
overview of the custom update process, explains the benefits of using the HP Client Updates Catalog for Microsoft System 
Center products, and gives some insight into how the catalog leverages Windows® Management Instrumentation (WMI) and 
the HP Client Management Interface (HP CMI). Finally, this paper describes the how to import the catalog into the Microsoft 
System Center family of products and deploy HP software updates to HP client systems. 

Note 
Throughout this document, the terms SMS, Configuration Manager, SCE, System Center Essentials, Microsoft system 
management products or Microsoft System Center family of products are used interchangeably. They all refer to the 
Microsoft management products supported by the HP software update catalog in the section Supported Microsoft System 
Management products. 

Introduction 

Update management—the ability to identify and selectively deploy updates in a timely and automated manner—is an 
important function of computer maintenance. Update management can help maintain the security and the productivity for 
the managed organization. HP now offers a mechanism to streamline updates for HP systems within a Microsoft System 
Center management infrastructure. The HP Client Updates Catalog contains software driver and patch information for 
desktops, notebooks, and workstations. It provides the detailed platform information for software updates in order to 
target appropriate client systems within the managed enterprise.O rganizations can integrate and deploy HP software 
updates quickly and easily while using Microsoft System Center products such as System Center Configuration Manager or 
System Center Essentials (SCE), or System Management Server (SMS). 

Terminology 

Table 1. Terminology 

Abbreviation/Acronym Meaning 

Configuration Manager Microsoft System Center Configuration Manager 

SCE Microsoft System Center Essentials 

SCUP Microsoft System Center Updates Publisher 

 

Benefits 

The HP Client Updates Catalog for Microsoft System Center products provides detailed platform information for software 
updates, with applicability and installed rules to determine whether an update is appropriate for the target clients within the 
managed enterprise and, if so, whether the update is already installed. Administrators do not have to manually define HP 
software updates as custom updates in Microsoft System Center products. 

If the management console can connect to ftp.hp.com, then corporate IT departments can download HP software updates 
from the FTP site directly to their Microsoft System Center product. 

HP Client Updates Catalog for Microsoft System Center products 

Overview 
HP Client Updates Catalog for System Center products: 

• Contains information about HP software updates (also known as SoftPaqs), such as title, description, supported 
languages, download URL, applicability rules, installed rules, and so on 

• Does not contain the binary code of a software update 

• Includes only software with a self-contained executable setup program that can be silently installed in Windows 
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• Includes only update information for commercial desktops, notebooks, and workstation platforms 

• Does not contain update information for thin clients or servers 

• Is digitally signed by HP 

• Is available at ftp://ftp.hp.com/pub/softlib/software/sms_catalog/HpCatalogForSms.latest.cab 

Supported Microsoft System Management products 
• Microsoft System Center 2012 Configuration Manager Service Pack 1 (SP1) and R2 

• Microsoft System Center Configuration Manager 2007 

• Microsoft System Center Essentials 2010 

• Microsoft System Center Essentials 2007 

• Microsoft System Management Server 2003 R2 

HP software update applicability rules 

• Each HP software update included in the catalog has three sets of rules: 

– Prerequisite rules—high-level rules for the client scan tool to determine if the update is applicable to a client 

– Applicability rules—low-level rules for the client scan tool to determine if the update is applicable to a client 

– Installed rules—rules for the client scan tool to determine if the update is already installed on a client 

Prerequisites rules 
• Must be an HP computer* 

• Supported operating system 

Applicability rules 
• Supported languages of the software update 

• Supported platforms* 

• Supported devices* (if the software update is device specific) 

Installed rules 
• For a system BIOS update, the BIOS release date* is later than or equal to the release date of the software update 

• In the case of a non-system BIOS update, the significant file of the software update exists on the machine 

If the client scan tool finds that all prerequisite rules and applicability rules evaluate to true and the installed rules evaluate 
to false (not installed yet), the software update is applicable to the client and is installed during the next scheduled update 
to the client. 

Note 
*These checks are done by calling the WMI and the extended HP CMI detailed in Windows Management Instrumentation and 
the HP Client Management Interface.  
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Windows Management Instrumentation and the HP Client Management 
Interface 

HP software update definitions in the catalog provide applicability rules to the client scan tool of an SMS product. Many of 
those rules query the WMI to determine whether a software update is applicable to a target client system. The following 
shows the WMI rules, their namespace, and the relevant query. 

Table 1. Example namespace and WMI queries in the catalog 

Rule WMI namespace Query 

HP machine Root\CIMV2 select * from Win32_ComputerSystem where 
Manufacturer='Hewlett-Packard' 

BIOS release 
date 

Root\CIMV2 select * from Win32_BIOS where ReleaseDate<=’<software 
update BIOS release date>’ 

Supported 
platforms 

Root\CIMV2 
select * from Win32_BaseBoard where Product LIKE ’<system ID>’ 

Supported 
devices 

Root\CIMV2 select * from Win32_PnpEntity where DeviceID LIKE ’<device ID>’ 

Root\HP\InstrumentedBIOS select * from HP_PNPDevice where DeviceID LIKE ’<device ID>’ 

 

Note 
Root\HP\InstrumentedBIOS is the namespace provided by HP CHI. This interface is provided by the HP BIOS and passes 
hardware and system BIOS information to the WMI for manageability applications. 

Deploying HP updates using HP System Software Manager 

Administrators need to selectively distribute software updates to clients. One way to simplify and automate the software 
update process is to use HP SoftPaq Download Manager (SDM) and HP System Software Manager (SSM) with a Microsoft 
System Center product. 

SDM is a free tool to download HP updates by selecting platforms and operating systems. 

SSM is a free utility that helps streamline the mass deployment of system software updates to client PCs. SSM reduces the 
complexity of system software management by delivering the following capabilities: 

• Deploying system software updates (for example, drivers and BIOS) from a centralized file store to multiple client PCs—
simultaneously and automatically 

• Deploying customer-created update packages 

• Enforcing BIOS configurations and passwords 

• Logging the changes made to each computer 

Combining Microsoft System Center and SSM for the greatest benefit 
1. Download SDM and SSM from the HP client management website http://www.hp.com/go/clientmanagement. 

2. Configure a network file share as the file store for SSM. 

3. Run SDM and select the desired platforms and operating systems to download SoftPaqs into the file store. 

4. Deploy SSM to clients and configure SSM to run on clients with the configured file store on a scheduled basis using SMS. 

5. Download HP updates from the HP FTP site to the SSM file store. 

6. Let SSM run on clients and to determine automatically which updates are needed and install them. 

7. Import the HP Client Updates Catalog for Microsoft System Center products into the appropriate product. 

8. View the compliancy in the Microsoft System Center product after the custom update scan process and the inventory 
cycle run on the client. If an IT administrator lets SSM install HP updates, then they do not need to distribute the same 
updates using the Microsoft System Center product. They can use the Microsoft System Center custom update process 
to scan for compliancy only. 
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Overview of the third-party update process 

The following figure illustrates the two major phases of third-party updates in Microsoft System Center products. 

Figure 1. Overview of the third-party update process 

 

 

 

 

 

 

 

The specific details on the HP Client Updates Catalog and each supported Microsoft System Center products are listed in the 
next sections for clarification. 

1. Administrator downloads and imports the HP 
client catalog into the publishing tool. 

2. Administrator publishes updates to the site 
server. SCE does not have this step, since the 
publishing tool is built-in. 

3. Clients get policies to scan for updates. 

4. Clients download and scan for update 
compliance. The scan engine might query WMI 
and HP CMI for applicability. 

5. Clients send the compliance information back 
to the site database. 

 

1. Administrator selects and approves HP updates for 
distribution. 

2. The update packages are downloaded to the 
distribution point. 

3. Clients get the deployment policies. 

4. The update packages are downloaded and installed. 

5. Clients are re-scanned for compliance and the 
information is sent back to the site database. 
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System Center Configuration Manager and the HP Client Catalog 

Overview of Configuration Manager and the HP Client Catalog 
Configuration Manager utilizes Windows Server Update Services (WSUS) and the SCUP for the software update process. The 
SCUP allows an IT administrator to import and select custom software updates to publish to WSUS. 

The Configuration Manager custom update process includes three phases: 

1. Importing and publishing third-party updates 

2. Scanning clients for update compliance 

3. Deploying updates 

Importing and publishing third-party updates 
HP customers can configure the import list in the SCUP to reference the link to the catalog on the HP FTP site and import it 
into the SCUP. The administrator can then selects updates to publish to WSUS. Configuration Manager synchronizes with 
WSUS on schedule or on demand to insert the software update metadata into the Configuration Manager Software Update 
Point server role. When the synchronization is complete, a site-wide machine policy is created to allow managed systems to 
retrieve and initiate a scan for software update compliance. 

Scanning clients for update compliance 
When a managed system receives the machine policy, a compliance scan is scheduled. The Windows Update Agent (WUA) 
connects to the WSUS server, retrieves the list of updates and scans the managed system against the applicability and 
installed rules of each update. The Configuration Manager Software Update Client Agent sends compliance information back 
to the site server. Based on the compliance status, the administrator can see which updates are needed by managed 
systems and can then decide which updates to distribute. 

Deploying updates 
The administrator creates deployments and deployment packages to distribute the selected updates. When a targeted 
collection of clients receives a new deployment from the management point, the clients download the software updates 
from a distribution point that has a deployment package containing the necessary software update binaries. The binaries 
are then installed on the clients and the compliance status is reported to the site server. 

Installing and configuring Configuration Manager 
Configuration Manager, WSUS, and SCUP need to be installed and configured before importing the HP Client Updates 
Catalog for Microsoft System Center products. Make sure that the site server has been configured for software updates. 

• If you have the full version of Configuration Manager (2012 or 2007), follow the installation instructions provided in the 
documentation to install and configure the software.  

• If you would like to try Configuration Manager, you can download the evaluation version from 
http://www.microsoft.com/systemcenter. 

Helpful links for configuring the Configuration Manager: 

• For Configuration Manager 2007, see the Administrator Checklist: Configuring Software Updates at 
http://technet.microsoft.com/en-us/library/bb680647.aspx. 

• For the 2012 version, see Deploying Software and Operating Systems in System Center 2012 Configuration Manager at 
http://technet.microsoft.com/en-us/library/gg699393.aspx.  
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Importing the HP Client Updates Catalog into SCUP 2011 
After installing and configuring the Configuration Manager site server, WSUS, and SCUP, you can use the following steps to 
import the HP Client Updates Catalog. 

Note 
HP recommends evaluating these updates in a test environment before using them in a production environment. 

1. Select Start > All Programs > System Center Updates Publisher > System Center Updates Publisher 2011. 

If you have SCUP installed on Windows Server 2012, move the mouse to the bottom-right corner of the screen to 
display the Charm Bar, and then select the Search button (with the magnifying glass icon). Type System Center 
Updates Publisher, and then select the application icon on the screen. 

Figure 2. SCUP—Overview 

 

2. In the navigation pane, select Catalogs. The catalog workspace appears. 
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3. Select Add Partner Software Updates Catalogs on the Home tab of the ribbon menu. The Add Partner Software 
Updates Catalogs dialog appears. 

Figure 3. SCUP—Add Partner Software Updates Catalogs 

 

4. Select Hewlett-Packard Client Updates Catalog and select Add, and then select OK. The catalog appears in My 
software updates catalogs. 

Because the catalog entry is added to the SCUP database, you only need to add the HP Client Updates Catalog once; 
the next time you need to import the catalog, you can start at the next step. 

Figure 4. SCUP—My software updates catalogs 
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5. Select Import on the Home tab of the SCUP console to bring up the Select an import type dialog of the Import Software 
Updates Catalog Wizard. Since an entry is added to My software updates catalogs in the initial steps, the Import one or 
more catalogs from My Catalogs option is enabled and selected as the default. 

Figure 5. Import Software Updates Catalog Wizard—Select an import type 

 

6. Select Next. The Summary dialog displays the catalogs to be imported. 

Figure 6. Import Software Updates Catalog Wizard—Summary 
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7. Select Next. The SCUP downloads and validates the catalog and displays a security warning. 

Figure 7. Security Warning – Catalog Validation 

 

8. There might be a security prompt to accept software update binaries signed by Hewlett-Packard Company. The option 
Always accept content from “Hewlett-Packard Company” allows the administrator to publish multiple HP updates 
without having to accept each update content. Select the appropriate radio button, and then select Accept. 

The Progress dialog opens. 

Figure 8. SCUP – Import Software Updates Catalog Wizard – Progress 
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When the importation is complete, the Confirmation dialog appears. 

Figure 9. Import Software Updates Catalog Wizard—Confirmation 

 

9. Select Close. The SCUP window displays the Hewlett-Packard Business Clients node under All software updates. Select 
Hewlett-Packard Business Clients to display the HP client product types. 

Figure 10. SCUP—All software updates 
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Publishing HP updates to WSUS 
1. Select the desired updates to publish to WSUS. In the navigation pane of the SCUP console, select a category under 

Hewlett-Packard Business Clients to see all updates under that category. 

2. Double-click a software update in the list to see all details about the update. To ensure that the update works properly, 
do not change the software package properties. 

3. Right-click the desired software updates, and then select Publish on the ribbon.  

Figure 11. SCUP—Selecting updates to publish 

 

The Publish Software Updates Wizard appears. 

Figure 12. Publish Software Updates Wizard—Specify publish options 
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4. Select the appropriate publish option: 

• Automatic requires Configuration Manager Integration and only downloads the binaries of selected updates when 
they meet the client request count and package size threshold configured in SCUP Options. 

Go to Microsoft Technet for more details about SCUP publish options: http://technet.microsoft.com/en-
us/library/hh134730.aspx. 

• Full Content makes WSUS download the binaries of the published updates. Publishing several updates with the Full 
Content option might take some time.  

• Metadata Only sends only the information about published updates, not the binaries of those updates, to WSUS This 
option allows only the administrator to check for the client compliance. 

5. Select Next. 

Figure 13. SCUP – Publish Software Updates Wizard – Security Warning – Content Validation 

 
6. Select Accept if a security prompt appears.The Progress dialog displays the progress of the publishing process. 

Figure 14. Publish Software Updates Wizard—Progress 

 

7. Once the publishing is complete, select Close on the Confirmation dialog. Although the updates are published to WSUS, 
the data is not updated in the Configuration Manager site server database until the next synchronization between the 
Configuration Manager and WSUS. You can either wait for the scheduled synchronization or force a synchronization. 

Skip the following two sections if you are only interested in Configuration Manager 2007. 
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Synchronizing software updates from WSUS to Configuration Manager 2012 
1. For Windows Server 2008, select Start > All Programs > Microsoft System Center > Configuration Manager 

Console, and then select Configuration Manager Console. 

For Windows Server 2012, move the mouse to the bottom-right corner of the screen to display the Charm Bar, and 
then select the Search button (with the magnifying glass icon). Type Configuration Manager Console, then 
select the application icon on the screen. 

2. In the Configuration Manager console, select Software Library in the navigation pane.  

3. Expand Overview > Software Updates, right-click on All Software Updates, and then select Synchronize Software 
Updates. A Run Synchronization prompt appears.  

4. Select Yes.The synchronization process is initiated and might take a few minutes to complete. There is no visual 
indication that the process has completed. The following steps show how to view the synchronization log to determine 
if the process completed successfully. 

5. In the navigation pane, select Monitoring. 

6. Expand Overview > System Status, and then select Component Status. The list of Configuration Manager server 
components and their current statuses appear in the results pane. 

7. In the results pane, select and right click SMS_WSUS_SYNC_MANAGER, and then select Show Messages > All. The 
Configuration Manager Status Message Viewer opens, displaying the status messages for the WSUS Sync Manager. 
Notice the most recent messages with IDs of 6701, 6705 and 6702. These messages indicate the sync process has 
started, is in progress, and has completed, respectively. 

8. In the navigation pane, select Software Library. 

9. Expand Overview > Software Updates, and then select All Software Updates to see the published updates in the 
result pane. Right-click a column header and select ArticleID to show the SoftPaq ID. 

Additional criteria can be used to filter the list of updates. Select Add Criteria, and then select criteria 
Vendor=Hewlett-Parkard Business Clients to see HP updates. 

Select the Save Current Search or Save Current Search As button on the Home tab of the ribbon and to save the 
search criteria for future reference. To access the saved searched criteria, select the Save Searches button, select 
Manage Searches for Current Node, and then select the saved criteria. 

Figure 15. Configuration Manager—Software updates from the HP Client Updates Catalog 
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Notice that the initial values of Installed, Required, and Percent Compliant are zero. When the next software update 
scan occurs on client systems, the clients report to the site database whether each update is applicable or installed. 
Then, the administrator can see the reported data and decide which updates need to be distributed.  

• Installed displays the number of clients reporting that the update has been installed. 

• Required displays the number of clients reporting that the update is applicable and not yet installed or the installation 
status has not reached the site server database. 

• Percent Compliant displays the percentage of clients that already have an update installed or do not need the update. 

10. To check the software update scan schedule, select Administration in the navigation pane. Expand Overview > Client 
Settings, and right-click the name of a setting, like Default Client Settings, and then select Properties. The 
properties of the selected settings group appears. Select Software Updates on the left pane. 

Note the Software Update Scan Schedule in the software update settings. Once the client systems scan and report the 
compliance status, the administrator can decide which updates to deploy to target collections. 

Distributing an HP software update from Configuration Manager 2012 
The following steps show a simple deployment of one update. Configuration Manager allows an IT adminstrator to 
configure the software update list and deployment template ahead of time. See the Microsoft links in the section For more 
information for more details. 

1. Run the Configuration Manager Console. 

2. In the navigation pane, select Software Updates. 

3. Expand Overview > Software Updates, and then select All Software Updates. You can specify search criteria to show 
HP updates. 

A software update that was published with Full Content downloaded successfully to WSUS has a green arrow on the 
software update icon. The update is ready for distribution.  

A software update published with the Metadata Only option has a blue arrow. It cannot be deployed until it is published 
with Full Content option and its information is updated in the Configuration Manager after a successful synchronization. 

4. Right click an update that needs to be distributed, and then select Deploy in the popup menu. The General dialog box 
of the Deploy Software Updates Wizard (DSUW) appears. 

5. In the Name box, type the name of the update to be distributed. 

6. In the Description box, type a description for the update. 

If there is an existing deployment template to use, select Select Deployment Template, select the applicable 
template, and skip to Step 10. If there is not a deployment template, the deployment settings need to be manually 
specified. 

7. Select Browse to select the collection to target for this update, and then select Next. The DSUW Deployment Settings 
page appears. There are options to set whether the deployment is required or optional, and the state message detailed 
level returned by clients for this software update. By default, Wake on LAN is not enabled and updates can only be 
deployed within configured maintenance windows for the targeted collection.  

8. Select the appropriate values for your deployment, and then select Next. The DSUW Scheduling page appears. The 
administrator can set whether to use UTC or client local time to evaluate the deployment schedule, specify when the 
deployment will be made available to clients, and specify when the deployment becomes mandatory. By default, the 
deployment is available now and becomes mandatory in one week. 

9. Select the appropriate values for your deployment, and then select Next. The DSUW User Experience page display the 
options to display or hide the update and notification in Software Center on a managed client, to suppress a system 
restart for servers or workstations, or to allow a system restart outside of the maintenance windows. 

10. Select the appropriate values for your deployment, and then select Next. The DSUW Alerts page appears. There are 
options to disable Operation Manager alerts while the updates run and to generate Operations Manager alerts when an 
update fails. 

11. Select the appropriate values for your deployment, and then select Next. The DSUW Download Settings page appears. 
The administrator can set what Configuration Manager does when clients on a slow or unreliable network download 
update binaries and whether it allows clients to download updates from unprotected distribution points. 

12. Select the appropriate values for the deployment, and then select Next. The DSUW Deployment Package page 
appears. The administrator can enter the information of the new deployment package. 

13. In the Name box, type a name for the package. 

14. In the Description box, type a description. 

15. In the Package Source box, type a share where client systems have access so they can download the update binaries. 

16. Select the appropriate sending priority for the package, and then select Next. The DSUW Distribution Points page 
appears. 
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17. Select Add and select Distribution Point. The Add Distribution Points dialog box displays the sites that can be 
targeted. Under Available distribution points, select to select the distribution points for this deployment, and then 
select OK. The DSUW Distribution Points dialog box displays the distribution points. 

18. Select Next. The DSUW Download Location dialog box allows the administrator to configure whether to download 
updates automatically from the Internet or retrieve them from a network location. 

19. Select Download software updates from the Internet to pull the updates from the published location, and then 
select Next. The DSUW Language Selection dialog box allows the IT administrator to configure which languages the 
updates will be downloaded in. Notice that the default is the configuration of the software update point (SUP). 

20. Select Next to accept the configured languages. The DSUW Summary dialog box appears, indicating that you have 
successfully completed the wizard. HP recommends that you save the selected deployment properties as a template 
to save time and to ensure consistency. Select Save As Template, then enter a name for the template. 

21. Select Save. The DSUW Progress dialog box displays the progress of the deployment. When complete, the DSUW 
Completed dialog box displays the status on each phase of the deployment. 

22. Verify that each phase of the process was successful, including the download of the update file, and then select Close. 

The Configuration Manager Console displays the list of updates. The selected software update should be in focus and 
the detailed information should be displayed in the Summary tab. Select the Deployment tab next to it. Notice the 
deployment name and values listed from the DSUW. 

23. In the navigation pane, under Overview > Software Updates, select Deployment Packages. This shows the list of 
deployment packages. Select the package created earlier, right-click it, and select Show Members. Notice that the list 
of updates available in this deployment package is the same as the one selected prior to launching the DSUW. 

24. Now, select the package, right-click it, and select Properties.  

25. Select the Content Location tab. The distribution points assigned to this deployment package appear. Notice that 
these match the distribution points selected in the DSUW. 

Synchronize software updates from WSUS to Configuration Manager 2007 
1. Select Start > All Programs > Microsoft System Center > Configuration Manager 2007, and then select ConfigMgr 

Console. 

2. In the left pane, expand Site Database > Computer Management > Software Updates, right-click Update Repository, 
and then select Run Synchronization. A Run Update Synchronization prompt appears. 

3. Select Yes. The synchronization process is initiated and might take a few minutes to complete. There is no visual 
indication that the process has completed. The administrator can view the synchronization log to determine if the 
process completed successfully. 

4. In the left pane, expand Site Database > System Status > Site Status, expand the site server, and then select 
Component Status. The list of Configuration Manager server components and their current statuses appears. 

5. In the results pane, select and right click SMS_WSUS_SYNC_MANAGER, and then select Show Messages > All. 

The SMS Status Message Viewer for the site server window displays the status messages for the WSUS Sync Manager. 
Notice the most recent messages with IDs of 6701, 6705, and 6702. These messages indicate that the sync process 
has started, is in progress, and has completed, respectively. 

6. On the File menu, select Exit. The Configuration Manager Console window appears. 

7. In the tree pane, expand Site Database > Computer Management > Software Updates, select and right-click Update 
Repository, and select Refresh. The classification nodes under Update Repository are updated to include Hewlett-
Packard Business Clients. Depending on the classification of the published updates, it is possible that not all classification 
nodes contain Hewlett-Packard Business Clients. 

8. HP recommends that you create a Search Folder that contains all HP updates for business clients, regardless of the 
update category. Expand Update Repository, right click Search Folders, and then select New Search Folder. The 
Search Folder Criteria dialog appears. 
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9. Scroll down the Step 1 list and select Vendor. 

Figure 16. Search Folder Criteria 

 

10. In the Step 2 section, select <items to find>. The Search Text dialog appears. 

Figure 17. Search Text 

 

11. Select Hewlett-Packard Business Clients and select OK. 

12. Check Search all folders under this feature. 
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13. Enter a name for the search folder, such as Hewlett-Packard Business Client Updates, and then select OK to save. 

Figure 18. Search Folder Criteria —Hewlett-Packard Business Clients 

 

The new search folder appears under the Search Folders node. 

14. Select the Hewlett-Packard Business Client Updates search folder, or expand a classification node, expand Hewlett-
Packard Business Clients, and then expand a category (for example, Desktops). 

Figure 19. Configuration Management Console—Search Folder 
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Notice that the initial values under Compliant, Installed, Required, Not Required and Unknown are zero. When the next 
software update scan occurs on client systems, each client reports whether each update is applicable or installed. Then the 
administrator can see the reported data and decide which updates need to be distributed. 

• Installed displays the number of clients reporting that the update has been installed. 

• Required displays the number of clients reporting that the update is applicable and not yet installed, or the installation 
status has not reached the site server database. 

• Not Required shows the number of clients not applicable for an update. 

• Unknown displays the number of clients that have not had a successful scan for the software update compliance, or the 
scan result has not been reported to the site server. 

To check the software update scan schedule, in the left pane, expand Site Database, expand Site Management, expand 
your <site code – site name>, expand Site Settings, select Client Agents, right-click Software Updates Client Agent in the 
result pane, and then select Properties. Part of the General tab is the scan schedule. After the client systems scan and 
report the compliance status, the administrator can decide which updates to deploy to target collections. 

Distributing an HP software update from Configuration Manager 2007 
The following steps show the simple deployment of one update. The Configuration Manager allows the IT administrator to 
plan the software update list and deployment template ahead of time. See the Microsoft links in the section For more 
information for more details. 

1. Run the Configuration Manager Console. 

2. In the left pane, expand Software Updates, expand Update Repository, expand an update classification like Updates, 
expand Hewlett-Packard Business Clients, and then select All Updates. The information for all HP updates of the 
selected classification appears. 

3. Select an update to distribute, and then, under Actions, select Deploy Software Updates. The General dialog box of 
the Deploy Software Updates Wizard (DSUW) appears. 

4. In the Name box, type the name of the update to distribute. 

5. In the Description box, type a description for the update, and then select Next. The DSUW Deployment Template 
dialog box displays prompts to create a deployment template or to use an existing deployment template for 
distributing software updates. Either select an existing deployment template and skip to Step 12, or create a new 
deployment template following the next steps. 

6. Select Create a new deployment definition, and then select Next to create a deployment template. The Collection 
dialog appears. 

7. Select Browse. The Browse Collection dialog appears. Select the target collection for this update, and then select OK. 

8. Select Next. The Display/Time Settings dialog displays the options to display or suppress notifications on clients, to use 
UTC or client local time to evaluate deployment schedules, and to specify the duration of the deployment. 

9. Select the appropriate values for the deployment, and then select Next. The Restart Settings dialog appears. The 
administrator can suppress a system restart for servers or workstations and allow a system restart outside of the 
maintenance windows. 

10. Select the appropriate values for your deployment, and then select Next. The Event Generation dialog displays the 
options to disable Operation Manager alerts while updates run and to generate Operations Manager alerts if an update 
fails. 

11. Select the appropriate values for your deployment, and then select Next. The Download Settings dialog appears. The 
administrator can set what Configuration Manager does when clients on a slow or unreliable network download update 
binaries and whether to allow clients to download updates from unprotected distribution points. 

12. Select the appropriate values for the deployment, and then select Next. The Create Template dialog appears. By 
default, the selected deployment properties save as a template to save time and to ensure consistency for future 
deployments. Enter a name and a description for the template. 

13. Select Next. The DSUW Deployment Package prompt appears. Name the new deployment package. 

14. Select Create a new deployment package. 

15. In the Name box, type a name for the package. 

16. In the Description box, type a description. 

17. In the Package Source box, type a share where client systems have access so they can download the update binaries. 

18. Select Enable binary differential replication if you desire that clients using Background Intelligence Transfer Service 
continue downloading files within a file if they are disconnected during a file transfer, and then select Next. The DSUW 
Distribution Points dialog appears. 

19. Select Browse. The Add Distribution Points dialog displays the sites that can be targeted. Under Distribution points, 
select to select the site(s) to serve as the distribution point(s) for this deployment, and then select OK. The DSUW 
Distribution Points dialog displays the distribution points. 
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20. Select Next. The DSUW Download Location dialog allows you to select whether to download updates automatically 
from the Internet or to retrieve them from a network location. 

21. Select Download software updates from the Internet to pull the updates from the published location, and then 
select Next. The DSUW Language Selection allows the configuration of which languages the updates will be 
downloaded in. Notice that the default is the configuration of the SUP. 

22. Select Next to accept the configured languages. The DSUW Set Deployment Schedule allows the configuration of when 
the update deployment is available to clients and when the deployment becomes mandatory. Notice that the default 
values are to be available now and to become mandatory in two weeks time. By default, Wake on LAN is not enabled 
and updates can be deployed only within configured maintenance windows for the targeted collection. 

23. Select Next to accept the default values. The DSUW Summary dialog appears. 

24. Select Next. The DSUW Progress dialog displays the progress of the deployment. When complete, the DSUW 
Completed dialog displays the status on each phase of the deployment. 

25. Verify that each phase of the process was successful, including the download of the update file, and then select Close. 
The Configuration Manager Console displays the list of security updates in the results pane. 

26. In the left pane, select Deployment Management. The Deployment Management information appears. Notice the 
deployment name and values listed from the DSUW. 

27. In the left pane, expand Deployment Management, expand the name of your deployment, and then select Software 
Updates. The list of software updates in this deployment appears. Notice that the list of updates includes the update 
you selected prior to starting the DSUW. 

28. In the left pane, expand Deployment Packages, expand the intended deployment package, and then select Software 
Updates. The Software Updates information appears. Notice that the list of updates available in this deployment 
package is the one selected prior to launching the DSUW, which only included the selected update. 

29. In the left pane, expand Deployment Packages, expand your deployment package, and then select Distribution 
Points. The distribution points assigned to this deployment package appear. Notice that this matches the distribution 
points selected in the DSUW. 

 

Note 
Because the HP Client Catalog leverages WMI to check applicability rules, theWMI service needs to be running on clients that 
are scanned for applicable updates. 
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System Center Essentials and the HP Client Catalog 

Overview of System Center Essentials and the HP Client Catalog 
System Center Essentials (SCE) have a built-in publishing tool and leverage Windows Server Update Services (WSUS) to scan 
and update managed clients. The SCE third-party update process includes three phases: 

1. Importing and approving custom updates 

2. Scanning clients for applicability 

3. Installing updates 

Importing and approving custom updates 
HP customers can import the HP Client Updates Catalog for Microsoft System Center products into SCE using the SCE 
interface and included publishing tool. The SCE administrator approves the desired updates. Then, SCE synchronizes the 
approved updates with WSUS. 

Scanning clients for applicability 
The Windows Update Agent (WUA) on each managed system provides WSUS with a list of products installed. WSUS 
responds with the list of updates applicable to that system. The WUA evaluates the applicability rules of the updates. 

Installing updates 
The WUA downloads the binaries of the applicable updates, installs them, and reports the status back to WSUS. 

SCE installation 
SCE needs to be installed and configured before importing the catalog. If using the full version of SCE, follow the installation 
instructions provided in the documentation to install and configure the software. 

The evaluation version of SCE can be downloadedat http://www.microsoft.com/systemcenter/essentials/default.mspx. 

Importing the HP Client Catalog into SCE 2010 
HP recommends using SCUP 2011 to import the HP Client Catalog into SCE 2010, because the SCE console might crash 
when importing a third-party catalog containing revised updates if Microsoft KB2734608 is applied to WSUS. 

Microsoft .NET Framework 4 Full and the WSUS 3.0 SP2 hot fix (KB2530678) need to be installed prior installing SCUP 2011. 

SCUP 2011 Options must be configured to publish to the appropriate WSUS server. 

See the sections Importing the HP Client Updates Catalog into SCUP 2011 and Publishing HP updates to WSUS for 
information on importing the HP Client Catalog via SCUP. 

After one or more HP updates are published from SCUP 2011 to WSUS, go to the SCE console, select the Updates 
workspace, and then select Hewlett-Packard Business Clients to view the published HP client updates. Published updates 
from SCUP display as Unapproved updates. Review those and deploy to computer groups as needed. 
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Importing the HP Client Catalog into SCE 2007 
After installing and configuring SCE, use the following procedure to import the HP Client Updates Catalog into SCE using the 
SCE console. 

Note 
HP recommends evaluating these updates in a test environment before rolling them out to the production environment. 

1. Select Start > All Programs > System Center Essentials 2007 > System Center Essentials 2007 Console. The SCE 
Console opens. Notice that the console displays a navigation pane on the left side and a detail pane on the right side. 

 
Figure 20. SCE 2007 

 

2. Select Updates at the bottom of the navigation pane. The detail pane displays an overview of updates and actions. 

Figure 21. SCE 2007—Updates 
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3. Under the Actions: section, select Import updates from partner catalogs to launch the Update Catalog Import Wizard. 

Figure 22. Update Catalog Import Wizard 

 

4. From the Introduction dialog, select Next. SCE asks for confirmation to download the master catalog from Microsoft 
and display the list of Microsoft-verified partner catalogs. 

Figure 23. Update Catalog Import Wizard —Master catalog downloading confirmation 

 

Select Yes. The Select Product Catalog dialog is displayed. 
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5. The first option, Yes, import the following catalog, is selected by default. Verify that Hewlett-Packard – Hewlett 
Packard Client Updates Catalog is selected. 

Figure 24. Update Catalog Import Wizard —Select Product Catalog 

 

6. Select Next. SCE asks for confirmation to download the HP Client Updates Catalog from the HP site. 

Figure 25. Update Catalog Import Wizard —File Download 
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7. Select Yes. SCE downloads the catalog and loads it, listing the updates in the catalog. 

Figure 26. Update Catalog Import Wizard—Review Update Catalog Contents 

 

8. Review and verify the updates, and then select Import. By default, Show deployment options when this wizard 
closes is checked. Leave it checked to be prompted to select groups for installation at the end of the wizard. 

Figure 27. Update Catalog Import Wizard —Importing Catalog 
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9. Select Finish. If Show deployment options when this wizard closes was checked in the previous step, the Approve 
Groups for Installation dialog appears. 

Figure 28. Update Catalog Import Wizard—Importing Catalog —Approve Groups for Installation 

 

10. Select the computer groups to update. 

Note 
The options to create new computer groups and to set a deadline for clients to apply the updates are available. 

Select OK. The Approval Progress dialog is displayed. Select Details to view additional information. 

Figure 29. Update Catalog Import Wizard —Importing Catalog —Approval Progress 

 

11. When the approval process finishes, select Close. The Updates view of the SCE Console shows the imported updates 
and their status. 
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12. The administrator can select updates to Decline or Approve. Declined updates are automatically removed from the 
SCE Updates view. WSUS and WUA deploy the approved applicable updates to the selected systems and send the 
installation status back to SCE. 

Figure 30. SCE 2007 —Approved updates 

 

 

Issues & limitations 
KB 937467 
KB 937467-updated files are not downloaded to the Essentials 2007 server when importing updates from a partner 
catalog. If you installed the SCE RTM version, be sure to install the Microsoft System Center Essentials 2007 Post Release 
Hotfix Rollup from http://support.microsoft.com/kb/937467. 

HP Client Updates Catalog import time 
The SCE RTM version does not allow users to select desired updates from a partner catalog to import, and thus downloads 
all the update binaries in a catalog during the import. The import time for a large catalog can be hours. This problem has 
been submitted to Microsoft by HP. 

WMI 
The HP Client Updates Catalog leverages WMI to check applicability rules. The WMI service needs to be running on client PCs 
scanned for applicable updates. 
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SMS 2003 R2 custom updates and the HP Client Updates Catalog 

Overview of SMS 2003 R2 custom updates and the HP Client Updates Catalog 
SMS 2003 R2 contains two components to allow custom software updates: the Custom Updates Publishing Tool (CUPT) and 
the Inventory Tool for Custom Updates (ITCU). The CUPT can be installed on a workstation or on an SMS site server. CUPT 
allows SMS administrators to design and select custom updates to publish to SMS. The ITCU needs to be installed on an SMS 
site server. ITCU adds custom updates collections, a new package with the client scan program, and scheduled jobs for 
clients to scan for custom updates to the SMS site server. ITCU needs to be installed on an SMS site server. 

ITCU consists of two components: 

• An integrated scanner to evaluate target clients for software update compliance. 

• A publishing tool that lets HP and others create software update catalogs that can be imported into SMS. SMS uses these 
catalogs to determine whether available software updates are applicable to target client hardware, and automatically 
schedule updates as necessary. 

The SMS custom software update process includes three phases: 

1. Enabling custom updates 

2. Scanning for custom updates 

3. Deploying custom updates 

Enabling custom updates 
HP customers can download the HP Client Updates Catalog from the HP FTP site and import it into CUPT. The HP Client 
Updates Catalog defines all of the available updates. The administrator selects and publishes the catalog to the SMS site 
server. Then, SMS sends the catalog and the scan program to the appropriate distribution points. 

Scanning for custom updates 
After the custom updates are enabled, they are targeted to specific client collections. Clients within these collections 
retrieve the policy/advertisement from the management point in their scheduled policy update cycle. Clients then download 
the catalog and the scan program from the distribution point. The scan program executes and checks the machine against 
the applicability and installed rules in the updates catalog. HP updates have rules to check the WMI and HP CMI for 
applicability. Clients send inventory information back to the SMS site database. Based on the scan results, the SMS 
administrator can see which updates are needed by the clients and then can decide which of the updates to distribute. 

Note 
The SMS client scan tool requires MS XML 6.0 to work properly. See the section MS XML Parser 6.0. 

Deploying custom updates 
After the administrator determines which updates need to be distributed, they select the software updates and distribute 
them to clients by creating packages and advertisements for targeted collections using the wizard. Advertisements of HP 
software updates should be configured to be downloaded to the clients, not running directly from the distribution point. 

SMS downloads HP updates from the HP FTP site and sends the packages to the distribution point. Clients in the targeted 
collections retrieve the policy/advertisement from the management point. Clients download the update package and 
execute the patch install program. The patch install program spawns HP software update executables. Finally, client 
machines are scanned again to make sure that the updates installed and the inventory information is sent back to the site 
database. 

CUPT and ITCU installation 
CUPT and ITCU need to be installed and configured properly before importing the HP Client Updates Catalog for Microsoft 
System Center products. An MSDN subscriber can go to the MSDN subscriber downloads site, log in, and download SMS 
2003 R2. The site is http://msdn2.microsoft.com/en-us/subscriptions/. 

Without an MSDN subscribtion, HP recommends tyring the latest version of SCCM supported by Microsoft. 

Follow the instructions in the SMS 2003 R2 documentation to install CUPT and ITCU. 

 
 

29 

http://msdn2.microsoft.com/en-us/subscriptions/
http://www.microsoft.com/technet/sms/2003/evaluate/r2.mspx.


Technical white paper  |  HP Client Updates Catalog for Microsoft System Center Products 

 

Importing the HP Client Updates Catalog into SMS 2003 R2 
After installing SMS 2003 R2’s CUPT and ITCU on your SMS site server, use the following procedure to import the HP Client 
Updates Catalog and publish HP software updates to SMS. 

Note 
HP recommends evaluating these updates in a test environment before rolling them out to the production environment. 

Importing the HP Client Updates Catalog into CUPT 
1. Download the latest HP Client Updates Catalog for Microsoft System Center products from the HP FTP site at 

ftp://ftp.hp.com/pub/softlib/software/sms_catalog/HpCatalogForSms.latest.cab 

2. Select Start > All Programs > Systems Management Server > Custom Updates > Publishing Tool. 

Figure 31. CUPT 
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3. In the Actions pane, select Import Update(s). 

Figure 32. Import Software Updates Catalog Wizard —Select Import Method 

 

Select Next to accept the default Single Catalog Import. 

Figure 33. Import Software Updates Catalog Wizard—Select File 
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4. Select Browse to locate and select the latest catalog downloaded in Step 1, and then select Next. 

Figure 34. Import Software Updates Catalog Wizard—Summary 

 

5. Select Next. CUPT validates the catalog and displays a Security Warning asking for confirmation to accept this catalog, 
signed and published by Hewlett-Packard. 

Figure 35. Import Software Updates Catalog Wizard—Security Warning 
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6. If you accept the catalog, select Accept. The Progress dialog appears. 

Figure 36. Import Software Updates Catalog Wizard—Progress 

 

When finished, the Import Software Catalog Wizard confirmation dialog box displays the number of updates imported. 

Figure 37. CUPT – Import Software Updates Catalog Wizard - Confirmation 
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7. Select Close. 

Figure 38. CUPT —Imported updates 

 

8. To display the HP software updates, select Hewlett-Packard Business Clients under Custom Updates Publishing Tool. 

Publishing HP updates to SMS 
Select which updates to publish to SMS as follows: 

1. In the tree pane of the CUPT console, select an update category under Hewlett-Packard Business Clients. The updates 
for the selected category appear in the results pane. Updates are not initially flagged in the Publish column. 

2. Select the desired update and select Set Publish Flag in the Actions pane. The flag should turn to green. 

3. Double-click an update to see details. Do not change the software package properties, or the update might not work 
properly. 

4. Repeat Step 2 as many times as needed to flag the all updates to publish to SMS. 

5. Because HP software updates are defined with the appropriate operating system, language, platform, and device rules, 
an administrator can also select Hewlett-Packard Business Clients, and then select Set All Publish Flags in the 
Actions pane to select all HP updates. 

6. Select Hewlett-Packard Business Clients. 
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7. In the Actions pane, select Publish Updates to publish the flagged HP updates to SMS. The Publish Wizard appears. 

Figure 39. Publish Wizard —Specify Path 

 

8. Check Synchronize with Site Database of Systems Management Server, and then select Next. The Publish Wizard 
Summary dialog appears. 

Figure 40. Publish Wizard—Summary 
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9. Select Next. The updates are published to SMS. The progress dialog might show if there are several updates. 

Figure 41. Publish Wizard—Progress 

 

10. When finished, the Publish Wizard confirmation dialog displays that the synchronization was successful. 

Figure 42. Publish Wizard—Confirmation 

 

11. Select Close. The Custom Updates Publishing Tool window appears. 
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12. Run SMS Administrator Console on the SMS site. In the console tree, select Software Updates, select the Action 
menu, and then select Refresh. The list of software updates in the details pane should contain the custom updates 
that were published. 

Figure 43. CUPT—Imported software updates 

 

Notice that the Requested and Compliant values are zero. When the next custom update scan occurs, the clients download 
the latest update catalog and scan for applicability. When the next hardware inventory occurs, clients report to the SMS site 
database whether each update is applicable or installed for each client. Then, the SMS administrator can see the reported 
data and decide which updates need to be distributed. Requested displays the number of clients reporting that the update is 
applicable and not yet installed. Compliant displays the number of clients reporting that the update is already installed. 

To check the custom update scan schedule, select Advertisements in the tree pane, right-click Custom Updates Tool in the 
result pane, and then select Properties. Select the Schedule tab to view the custom update schedule. By default, it is every 
seven days from the time ITCU is installed.  

Distributing HP software updates from SMS 2003 R2 to HP client systems 
To distribute a custom update to SMS clients: 

1. In the SMS Administrator Console, select Software Updates. The list of inventoried software updates appears. Notice 
the number of updates listed and the information available for each update, including the Requested and Compliant 
values. 

2. Select Action > All Tasks > Distribute Software Updates. The Distribute Software Updates Wizard (DSUW) dialog 
appears. 

3. Select Next. The DSUW Specify a Software Update Type dialog appears. 

4. Select Select an update type > Custom Update > Next. The DSUW Create an SMS Package or Modify Packages and 
Updates dialog appears. 

5. Select Next to create a new package. The DSUW Identify the SMS Package dialog appears. 

6. In the Package name box, type the desired name of the package (usually the application name), and then select Next. 
The DSUW Customize the Organization dialog appears. 

7. In the Organization box, type the desired organization to push the software update (for example, Corporate IT 
Support), and then select Next. The DSUW Select an Inventory Scanning Program dialog displays a prompt for the 
package and program to verify that it has been run to ensure that the software updates information has been reported 
through hardware inventory. 
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8. Select Next to accept the default values of the Custom Updates Tool program and package. The DSUW Add and 
Remove Updates dialog displays the list of updates that are applicable for the site. The IT administrator can distribute 
more than one update in a single operation. 

9. Select the custom update for distribution, and then select Next. The DSUW Specify a Source Directory for Files dialog 
displays the default directory for the source files to be used as the SMS package (\\SMSServer\C$\<package 
name>), and prompts for a method to download the required updates. 

10. If the SMS server has an Internet connection and can access the HP FTP site, the administrator can leave the default 
option Download any available update source files for me checked, and then select Next. The wizard tries to 
download the updates from the FTP link. After downloading successfully, the DSUW Software Updates Status dialog 
displays the status of the update to be deployed. Under Ready, a value of Yes should be listed for all updates, 
indicating that the update file location has been designated. Skip to Step 17. 

If the administrator selects to download HP updates from the HP FTP site manually, select I will download the source 
files myself, and then select Next. The DSUW Software Updates Status dialog displays the status of the update to be 
deployed. Under Ready, a value of No is listed, indicating that the update file location has not been designated yet. 

11. Select Properties. The Distribute Software Updates Wizard dialog displays properties for the selected software 
update. Notice that options are available to import the update; to specify command line parameters; and to perform a 
download from the Internet. Also,if the updates are manually downloaded, notice that the value for Binary present is 
No, indicating that the source file location has not been configured yet. 

12. Select Import. The Open dialog prompts for the source file. 

13. Browse to where the HP update binary has been stored, and then select Open. The Distribute Software Updates Wizard 
dialog displays properties for the selected software update. Notice that the Binary present value is now Yes. In the 
Parameters box, notice that there is a default syntax to perform an unattended update. 

14. Select OK. The DSUW Software Updates Status dialog displays the status of the update to be deployed. Notice that 
under Ready a value of Yes is now listed, indicating that the source file is ready to be distributed. Also, notice that the 
total size of the SMS package is reported. If multiple updates are in the package, this indicates the accumulated size of 
all the selected updates. 

15. Repeat Steps 11 through 14 to import the binary for each update. 

16. Select Next. The DSUW Update Distribution Points dialog prompts you to select the SMS distribution points to use. 

17. Under Name, check the box with the SMS site server name, and then select Next. The DSUW Configure Installation 
Agent Settings dialog displays the default values for status reporting and system reboots. The default values are to not 
collect hardware inventory information immediately after the update installation and to postpone reboots for both 
servers and workstations. 

18. An administrator can check Collect inventory information immediately to send an immediate inventory report back 
to the SMS server after the installation, but that can lead to a significant impact on the network and the site server. 
Select Next. The DSUW Configure Installation Agent Settings dialog displays the default values for unattended 
installations and update enforcement. The default values are to perform unattended installations and to not include a 
maximum installation time. The default action is set to postpone restart after waiting five minutes for the user to 
respond to the installation request. The default time specified to complete the update installation is 30 minutes. 

19. Select Next to perform an unattended update. The DSUW Configure Installation Agent Settings dialog displays the 
default values for notifications and patch postponing. Notice that the default values are to use balloon notifications 
and to allow the user to postpone the update installation indefinitely. 

20. Select Next to accept the default values. The DSUW Advertise Updates dialog prompts you to advertise the software 
update through SMS. This ensures that all clients that require the update receive it and that failed installation attempts 
are retried every week. 

21. Select Advertise, and then select Browse. The Browse Collection dialog displays the list of collections. 

22. Select Custom Updates Tool, and then select OK. The DSUW Advertise Updates dialog displays the advertisement 
name, collection to be advertised to, and the weekly recurrence schedule. 

23. Select Next. The Completing the Distribute Software Updates Wizard dialog promps you to complete the deployment 
using the DSUW. 

24. Select Finish. The SMS Administrator Console window appears. 

25. The HP custom update packages must be downloaded to client machines instead of running them directly from an SMS 
distribution point. Complete the following steps: 

• In the tree pane, select Advertisement. The result pane displays the list of advertisements. 

• Right-click on the HP custom update advertisement created previously, and then select Properties. 

• Select the Advanced Client tab. Under When a distribution point is available locally, select Download program 
from distribution point and under When no distribution point is available locally, select Do not run program, and 
then select OK. These options ensure that the package is downloaded from the distribution point to a client and the 
patch runs locally on the client machine. 
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Issues and limitations 
MS XML Parser 6.0 
The SMS client scan tool requires MS XML 6.0 to work properly. SMS administrators need to distribute MS XML 6.0 to clients 
before trying to deploy HP updates using the SMS custom update process. This issue has been confirmed by Microsoft. Go to 
the Microsoft Help and Support article at http://support.microsoft.com/kb/933535 for more information. 

On a client that does not have MS XML 6.0 installed, the scan tool logs the following error in ScanWrapper: log Failed to 
execute the WMI query. IWbemServices::Exec Query retu0x8004 1003. Because any WMI query checks the manufacturer, 
platforms and devices will fail, and the scan always yields not applicable for all updates to a client. 

WMI 
The HP Client Catalog leverages WMI to check applicability rules. The WMI service needs to run on clients and the SMS client 
scan tool needs to have adequate permission to query WMI. 

HP software update installation must be downloaded to clients 
As specified in the instructions to distribute software updates from SMS to clients, SMS notifications for HP software 
updates must be configured to download to clients and run there, not to run directly from the SMS distribution point. 

Contacting HP support 

Before contacting HP support for issues about software updates for HP Client PCs 
Before contacting HP, perform the following procedure: 

1. Gather the following information: 

A. Software update article ID (aka SoftPaq number, for example, sp23456) 

B. Hardware product model number 

C. Client operating system type and version 

D. Detailed error message 

E. Related hardware devices (if applicable) 

F. Technical support registration number (if applicable) 

2. If the issue is related to the installation of an update or occurs soon after installation: 

A. Copy the MSI installation log located in the temporary files directory (use the %TEMP% environment variable to 
locate). This file is usually located in a "1" directory and has a random name that is formatted like 
"MSI<RandomChars>.LOG". In some cases, a specific log file is specified in the installation command line. Copy that 
file. 

B. Copy the WindowsUpdate.log file and note the section that includes the installation error, if any. This file is inthe 
Windows installed folder. 

3. Prepare a complete, detailed explanation of the issue, including: 

A. The exact point of failure (for example, during installation or after installation, and a description or screen capture 
of error messages and error codes) 

B. A detailed description of the computers being configured (model, hardware configuration, and NIC details) 

C. A description of other circumstances, such as: 

i. Does the same update install successfully on a different client? 

ii. Does the same update install successfully if installed manually? 

This helps reduce the time needed to diagnose the issue at hand. 
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How to contact HP 
Use the following methods to contact HP support: 

• Go to the Contact HP worldwide website: 

http://www.hp.com/go/assistance 

• Use the Contact HP link on the HP Support Center website: 

http://www.hp.com/go/hpsc 

In the United States, call +1 800 334 5144 to contact HP by telephone. This service is available 24 hours a day, 7 days a 
week. For continuous quality improvement, conversations might be recorded or monitored. 
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For more information  

Microsoft System Center products and Knowledge Base articles referenced in the paper 
Microsoft System Center products 
http://www.microsoft.com/systemcenter/default.aspx 

Systems Center Essentials 
http://www.microsoft.com/systemcenter/essentials/default.mspx 

Systems Management Server 2003 Concepts, Planning, and Deployment Guide 
http://www.microsoft.com/technet/prodtechnol/sms/sms2003/cpdg 

KB937467 - Updates cannot be distributed to managed hosts, or you cannot import updates directly from partners 
when you import updates from partner catalogs in System Center Essentials 2007 
http://support.microsoft.com/kb/937467 

KB933535 - The Inventory Tool for Custom Updates in SMS 2003 R2 does not run WMI queries on client computers 
that do not have MSXML 6.0 installed 
http://support.microsoft.com/kb/933535 

Microsoft System Center Configuration Manager - Software Updates 
Introduction to Software Updates in Configuration Manager 2012 
http://technet.microsoft.com/en-us/library/gg682168.aspx 

Software Updates in Configuration Manager 2007 
http://technet.microsoft.com/en-us/library/bb680701.aspx 

 

 
 

Sign up for updates 
hp.com/go/getupdated 
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